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eTutorial to Access XP 

 

What is a database? 
A database is simply a collection of data organized for rapid access and 
retrieval. You probably use a number of databases every day without even 
knowing it. A phone book, for example, is basically a paper-and-ink database 
containing a list of entries that include the names of individuals and their 
telephone numbers. In database parlance, each complete entry is a record, 
and each discrete piece of information in each record—i.e., each individual’s 
first name, their last name, and their phone number—is a field. Entries (or 
records) in a phone book database are listed alphabetically by last name to 
make information retrieval easy and intuitive. 

Microsoft Access 2003 is a powerful software application that creates and 
manages databases. It is therefore known as a database management 
system, or DBMS. While Access is easy to use, it is capable of storing, 
manipulating, and organizing vast quantities of data. As a result, you can use 
Access to organize and manage anything from a personal CD collection to the 
inventory of a large manufacturing company. 

There are two principal kinds of databases: flat-file databases, and relational 
databases. A flat-file database stores all of its information in a single list, or 
table. The phone book 
described above is 
analogous to a flat-file 
database: it consists of 
one very long table of 
records, sorted 
alphabetically. 

Flat-file databases can be 
useful for organizing 
simple collections of data, 
like shopping lists, 
addresses, or email 
contacts. You can actually create a flat-file database using a spreadsheet 
application like Excel. If you were to enter all of your email contacts, 
including each person’s first name, last name, and email address, in a single 
Excel spreadsheet, you would have a simple flat-file database. 

The worksheet itself would correspond to a single database table containing 
multiple records, with each record containing multiple fields (i.e., contact first 
name, contact last name, contact’s email address). Similarly, you could do 
precisely the same thing in Access by constructing a single table containing 
the same information. 
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Often, however, flat-file databases can prove unwieldy. For example, let’s 
say that you want to create a database to store and organize information 
about your enormous CD collection, which includes many CDs by the same 
artists. You’d like the database to contain the title of each CD, and the name 
of the artist who recorded it. In a flat-file database, you would create a single 
table containing fields for the artists’ first names, their last names, and the 
titles of their CDs. You would then have to create a separate record for each 
CD by the same artist, entering and reentering the first and last names of the 
artist over and over again in each record. 

 

In short, using a flat-file database can force you to enter lots of redundant 
information. Relational databases don’t suffer from this problem, however. In 
fact, they allow you to store and organize vast amounts of information with 
minimal redundancy and duplication by storing related pieces of data (like 
artist’s names and CD titles) in separate tables. They also allow you to 
access, manipulate, and display related data quickly and easily by creating 
links between them. Much of the power and flexibility of Access stems from 
its ability to construct and manage relational databases (which is why Access 
isn’t just a DBMS, but an RDBMS—a relational database management 
system). 

Relational databases store information in multiple tables, and relate those 
tables to one another using special fields called keys. 

For example, if we were to create a relational database for the CD collection 
mentioned above, we would probably want to use at least two tables: an 
Artist table, and a CD table. The Artist table would contain three columns (as 
in Excel, a vertical series of fields is a column; a horizontal series of fields is 
a row): First Name, Last Name, and ArtistID. ArtistID will serve as a special 
kind of key for this table, and will be shared with the CD table. 
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The CD table, meanwhile, would contain three columns: CD Name, CDID, 
and ArtistID. Anything look familiar? That’s right; ArtistID also appears in the 
Artist table. 

 

In the Artist table, ArtistID functions as something called a primary key. 
Each record in the table is identified by its unique primary key value (and as 
you can see, each record in the Artist table does indeed contain a different 
ArtistID value). Similarly, in the CD table, CDID is the primary key, so each 
record in the CD table contains its own unique CDID value. 

Identifying each record in a table with a unique primary key value ensures 
that when it comes time to reassemble the information contained in records 
that are stored in multiple tables, there won’t be any confusion over which 
records to use. 

The ArtistID field in the CD table, however, functions as a kind of borrowed 
field, known as a foreign key. Foreign keys relate one table to another—in 
this example, each CD in the CD table is linked to the particular artist who 
recorded it by that artist’s unique ArtistID from the Artist table. Each record 
in the CD table has basically been “tagged” with an ArtistID from the Artist 
table. 

In a relational database such as this, if you wanted to enter multiple CDs by 
a single artist, you would simply create a single record containing the artist’s 
first and last name (and a unique ArtistID number) in the Artist table. You 
would then enter as many CDs by that artist as you liked in the CD table, 
including the corresponding ArtistID number each time. (Access can even 
make this process as simple as choosing the name of the artist from a drop-
down list containing all of the names from the Artist table; when you select 
the artist you want, Access enters the ArtistID in the CD table for you.) If 
you wanted to search, or query, the database for all of the CDs by a 
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particular artist, Access would simply look for all of the CD table records 
containing the appropriate ArtistID. 

How do I create a database? 
The first time you start Access, the New File task pane will be open on the 
right side of the Access application window.  

 

If you do not see the New File task pane, you can view it by selecting New 
from the File menu, or press Ctrl+N on your keyboard. If you still do not see 
it, from the View menu, click Toolbars then Task Pane. 

To create a new database, click “Blank Database” under “New” in the New 
File task pane. 

The File New Database dialog box will appear. 

 

Specify a name and location for the database and then click Create. 

Once you have created the database, the Database dialog will appear. 

The PCC CIS eTutorial to Access  6 of 22 



At this point, you can 
create populate the 
database with tables, 
forms, queries, and 
reports as described in 
other sections of this 
eTutorial. 

You can also create a 
database using 
templates that provide 
commonly used tables 
and fields. Here are two 
ways to create a 
database using a 
template: 

Using the Database Wizard 
• In the New File task pane, under Templates, click General Templates 

• The Templates dialog box will appear. On the Databases tab, click the 
icon for the kind of database you want to create, and then click OK. 

 

• In the File New Database dialog box, specify a name and location for 
the database, and then click Create 

• Follow the instructions in the Database Wizard to select the tables and 
fields that you want your database to contain 
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Downloading a Template 
In the New File task pane, under Templates, either search for an appropriate 
template by entering a search term in the text box under “Search online for:” 
or click “Templates on Office Online” to browse for a suitable template on the 
Templates portion of the Microsoft Office Online website: 
(http://office.microsoft.com/templates/default.aspx). 

Database templates are indicated by the Access icon. 

• Click on a template and then click Download now. Follow the 
directions provided onscreen to extract the database template from 
the downloaded file.  

• Double-clicking the extracted template will open the new database in 
Access. The Main Switchboard  window will appear. Switchboard is the 
Access term for its startup window.  You may now begin using the new 
database. 

How do I create a table? 
To create a table, you must specify the fields that the table contains. A field 
is a table element that 
contains a specific item 
of information, such as a 
last name, first name, or 
telephone number. The 
terms “field” and 
“column” are often used 
interchangeably. 

Open your database, and 
the Database window will 
appear. 

Double-click Create 
table in Design view. A 
new blank table will 
appear in design view. 
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Design view illustrates the structure of a table and allows you to create and 
modify its fields without displaying any of its data. (Design view can also be 
used to create and modify the design of queries, forms, and reports, all of 
which you will learn about later.) The design view window contains three 
main columns: Field Name, Data Type, and Description. Placing your cursor 
in any of the fields in the Design view window causes a brief description to 
appear in the right-hand corner of the Field Properties pane in the bottom 
portion of the window. 

Enter the names of the fields that you wish to create in the Field Name 
column. Choose names that are descriptive and easy to interpret. Someone 
else might eventually need to use or modify your database, and you’ll want 
to make it as easy as possible for them to understand its structure and 
design. 

Once you have entered your field names, you must define the kinds of data 
that the fields can contain. When you place your cursor in a Data Type cell, a 
down-arrow appears on the right side of the cell. Click on the down-arrow to 
display a list of data types. 

It’s important to choose the right data type. If you want the field to be able 
to contain both numbers and letters, for example, select the Text data type. 
If you want the field to contain numbers upon which you can perform 
mathematical operations, like addition, subtraction, multiplication, and 
division, choose the Numbers data type. If you want the field to contain 
prices, payroll figures, or other dollar amounts, use the Currency data type. 
If you want the field to contain dates and times, select the Date/Time data 
type. 

Be aware that data types are restrictive. For example, if you specify the 
Numbers data type for a field, you will not be able to enter text in that field. 
Similarly, if you specify the Text data type, you will be able to enter both 
letters and numbers in the field, but you won’t be able to perform 
mathematical operations on the contents of the field (you couldn’t, after all, 
subtract a number from a letter). In addition, some data types do not accept 
Null values, which basically means that you can’t leave fields with such data 
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types blank (i.e., you have to enter data in them, whether you like it or not). 
For complete descriptions of all of the data types and their various 
properties, see Access Help. 

If you wish, in the Description field, you may enter comments to help explain 
what the function or purpose of the field is. Field descriptions can help you 
remember what you were thinking when you designed the table—a useful 
trick if you need to come back and modify the table at a later date. They can 
also help others figure out what you were trying to do. 

Once you have created a field or fields, you need to specify the primary key 
for the table. As mentioned previously, in “What Is a Database?” a primary 
key is a special field that uniquely identifies each record in a table. Primary 
keys are used to relate tables to one another; by using the primary key from 
one table as a foreign key in another table, for example, we can relate the 
two tables to each other.  

Each record in a table must contain a unique primary key value. The easiest 
way to ensure this is to specify the AutoNumber data type for the field you 
wish to use as a primary key. 

When you specify 
AutoNumber as 
the data type for 
a field, Access 
automatically 
generates a 
unique numerical 
value for that field 
every time you enter a new record in the table. By default, Access starts 
from the number 1 and increases incrementally by 1 with each successive 
record.  

To specify a field as the primary key for a table, select the field by clicking on 
the box to the left of Field Name column or by inserting your cursor in the 
Field Name, Data Type, or Description fields. Then click Primary Key from 
the Edit menu. A small key symbol will appear next to the field name. 

An additional way to create a table: 

• In the Database window, double-click Create table by using wizard. 

• Use the Table Wizard to construct your table using a variety of 
predefined fields. 

• Once you have saved your table, you can open it up in design view to 
modify its fields.  

Try It! 
• Create a new database. Name it “CD Collection.” 

• In the database window, double-click Create table in Design view. A 
new table, named Table1, will appear in design view. 
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•  Create the following fields (data types are given in parentheses): 

• CDID (AutoNumber) 

• CDTitle (Text) 

• Price (Currency) 

• ArtistID (Number) 

• Set the CDID field as the primary key for the table by positioning your 
cursor in the CDID row, and selecting Primary Key. You will see a key 
symbol appear to the left of the field name.  

• Close the Table1 window.  

• A pop-up window will appear, asking if you want to save changes to 
the design of Table1. Click Yes. 

• A Save As dialog will appear. Enter “CD” in the Table Name field and 
click OK.  

• The CD table will now appear in the Table section of the database 
window. 

•  Repeat the above steps to create an additional table named Artist. 
This table should include the following fields (set the ArtistID field as 
the primary key for this table): 

• ArtistID (AutoNumber) 

• ArtistFirstName (Text) 

• ArtistLastName (Text) 

How do I create relationships between tables? 
Relationships between tables are what make relational databases tick. Two 
tables are related to one another when the values from one or more key 
fields (like the ArtistID field in the Artist table) in one table are matched to 
one or more fields in the other table (like the ArtistID field in the CD table). 

The basis for a relationship exists in the case of the CD and Artist tables that 
we created in the previous section. The tables were designed so that primary 
key values from the Artist table can be shared with the CD table. This will 
allow us to link, or relate, the two tables to one another through the use of 
shared values.  

Relationships between tables fall into three categories: one-to-many, one-to-
one, and many-to-many. 

If two tables (Table A and Table B) are related through a one-to-many 
relationship, then each record in Table A may be matched to many records in 
Table B, but each record in Table B may only be matched to one record in 
Table A. A record in Table A that is matched to multiple records in Table B is 
known as a “parent,” and each record in Table B that belongs to that parent 
is known as a “child.” Table A is itself said to be the parent of Table B, which 
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is in turn said to be the child of Table A. (Why the parent-child terminology? 
Well, a mother or father may have many children, but each child can have 
only one biological mother or father.) 

If two tables are related through a one-to-one relationship, then each record 
in one table may be matched to just one record in the other table.  

Finally, if two tables are related through a many-to-many relationship, then 
each record in the each of the two tables may be related to many records in 
the other table. 

One-to-many relationships are by far the most common kinds of relationships 
among tables. One-to-one relationships are rare, and many-to-many 
relationships between tables violate database design principles and Access 
can not handle them. 

The Artist and CD tables we created in the previous section were designed to 
exist in a one-to-many relationship: Each record in the Artist table may be 
matched to multiple records in the CD table, while each record in the CD 
table must be matched to just one record from the Artist table. That’s why 
we created an ArtistID field in the CD table; each record in the CD table will 
be “tagged” with a particular ArtistID value, identifying the artist to whom it 
belongs. Each artist listed in the Artist table therefore has the potential to be 
the parent of many children in the CD table, while each CD listed in the CD 
table can have only one parent in the Artist table. 

Placing shared fields into tables isn’t enough to establish a relationship in 
Access, however. We also have to define the relationship using the tools that 
Access provides just for that purpose. 

To establish relationships between tables, open the database containing the 
tables in question. Then click the Relationships button in the main Access 
window or click Relationships from the Tools menu. 

 

Relationships Button 

The Show Table dialog box will open with the Relationships window in the 
background.  

Select the first table for which you wish to 
establish a relationship and click Add. A 
small window representing the table and 
its fields will appear in the Relationships 
window. Repeat this procedure until all of 
the tables you wish to link appear in the 
Relationships window. To add multiple 
tables in a single stroke, hold down the Ctrl key while selecting the tables 
you want, and then click Add. 
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When you’re done adding tables, click “Close” to close the Show Tables 
dialog box and enter the Relationships window. 

 

If you wish to remove a table from the Relationships window, right-click the 
table window and select “Hide Table” from the shortcut menu that appears. 

In the first table window, select the field you want to use to establish a 
relationship and drag it to its matching field in the second table window 
(make sure to position your pointer over the correct field in the second table 
window before releasing).  

 

You may need to resize the table windows to see all of the fields they 
contain. To resize a table window, position your pointer on its border and 
drag until all fields are visible. 

The Edit Relationships 
dialog box will open. Make 
sure that the correct 
tables and fields are listed 
in the “Table/Query” and 
“Related Table/Query” 
columns. 

Notice the “Enforce 
Referential Integrity” 
checkbox. If the “Enforce 
Referential Integrity” 
checkbox is not checked, 
the “Cascade Update 
Related Fields” and 

“Cascade Delete Related Records” checkboxes will be grayed out. Checking 
the “Enforce Referential Integrity” checkbox makes the “Cascade Update 
Related Fields” and “Cascade Delete Related Records” checkboxes available. 
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Once you have verified that the correct 
tables and fields are listed, and you have 
checked all of the desired checkboxes, 
click Create to establish the relationship 
(at the bottom of the dialog box, Access 
displays the kind of relationship that will 
be established between the tables). The 
Edit Relationships dialog box will close, 
and a line will appear between the two 
table windows in the Relationships 
window, indicating that the tables are 
related to one another.  

If you enforce referential integrity 
between tables involved in a one-to-many 
relationship, Access will display a small 
“1” next the parent table and a link or 
“infinity” symbol next to the child table. 

To save the relationship, click Save from 
the File menu, or close the Relationships 
window and click Yes when asked if you 
want to save changes to the layout of the 
Relationships window. 

Try It! 
• Open the CD Collection database. 

• Click on the Relationships button in 
the main Access window. 

• Hold down the Ctrl key and select 
both the Artist and CD tables. 

• Click Add. 

• Select the ArtistID field in the Artist 
table window and drag it to the ArtistID field in the CD table window. 

Referential Integrity 

Enforcing referential integrity 
prevents related tables from 
slipping out of sync with one 
another, and can prevent you from 
accidentally deleting or changing 
data in one table without deleting 
or changing related data in another 
table. Checking “Cascade Update 
Related Fields” and “Cascade 
Delete Related Records” ensures 
that if you make changes or 
deletions in one table, Access will 
automatically carry those changes 
or deletions through all related 
tables. 

For example, if you were to delete 
an artist’s name from the Artist 
table in the CD Collection 
database, you would probably want 
to delete all of the artist’s CDs 
from the CD table, as well. 
Enforcing referential integrity and 
checking “Cascade Update Related 
Fields” and “Cascade Delete 
Related Records” would guarantee 
that deleting an artist’s record from 
the Artist table would result in the 
automatic deletion of all related CD 
records from the CD table. In other 
words, Access would make sure 
that changing or deleting a parent 
record would mean changing or 
deleting all of its children, as well. 

• In the Edit Relationships window, verify that the Artist and CD tables 
have been selected under “Table/Query” and “Related Table/Query,” 
respectively, and that the ArtistID field has been selected for both. 

• Check the “Enforce Referential Integrity” checkbox. 

• Check the “Cascade Update Related Fields” and “Cascade Delete 
Related Fields” checkboxes. 

• Click Create. 

• Verify that a line indicating a one-to-many relationship now connects 
the Artist and CD tables in the Relationships window, the Artist table is 
the parent table, and the CD table is the child table. 

The PCC CIS eTutorial to Access  14 of 22 



• Close the Relationships window. When asked if you want to save 
changes the layout of the Relationships window, click Yes. 

How do I enter data into a table? 
To enter data directly into a table, first open the database in which it is 
located. Then open the table in datasheet view by double-clicking the table in 
the database window. (If the table you wish to open does not appear in the 
Database window, make sure that the Table button in the Objects pane of 
the Database window is depressed.) 

Unlike design view, which gives you access to the structural components of a 
table (i.e., its fields and their properties) but not the data it contains, 
datasheet view allows you to see and access table data in a row-and-column 
spreadsheet format. 

Once you have opened a table in datasheet view, you can switch to design 
view by clicking the Design button in the Database window. Similarly, you 
can switch back to datasheet view from design view by clicking the Open 
button in the database window. You can also switch between Datasheet view 
and Design view by selecting “Datasheet View” or “Design View” from the 
View menu in the main access window. 

Once you have opened 
a table in Datasheet 
view, you can enter 
data directly into the 
table by clicking on a 
particular table cell and 
manually typing in the 
data. To add a new 
record to a table, select 

the Data Entry option from the Records menu.  When you select Data Entry, 
you see one empty row of the table in which to create the new record.  (If 
you need to enter related data in multiple tables, it’s best to create a form 
for data entry. See “How Do I Create and Use a Form for Data Entry?”) 

To save your data, select “Save” from the File menu, or press Ctrl+S. You 
can also simply close the table; when you close a table in Datasheet view, 
Access automatically saves any changes to the table data. 

Access also allows you to import data from other databases, and even from 
other programs. For example, if you already have data stored in an Excel 
spreadsheet, in a text file, or even in an HTML document, Access can import 
that data into one or more database tables. However, Access can only import 
data to an existing table from a database, a spreadsheet, or a text file. If you 
wish to import data from some other source, Access will create a new table 
or tables in which to store it.  

To import data, select “Get External Data” from the File menu, and then 
select “Import.” The Import dialog box will open. Select the type of data 
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source you wish to use from the “Files of type” drop-down list (e.g., Excel 
spreadsheet, text file, HTML document), and locate the data source in the 
main Import window. Click “Import.” The Import Wizard dialog box will 
appear. Follow the instructions provided by the import wizard to import your 
data. 

How do I build forms for data entry? 
Forms allow you to view and enter table data through a user-friendly 
interface. It is often simpler and more convenient to enter data using one or 
more forms than it is to enter data directly into tables in Datasheet view. 

To create a form for data entry, first make sure that your database is open. 
Click Forms under Objects in the Database window, and then double-click 
Create form by using wizard. The Form Wizard dialog box will appear. 
(You can also open the Form Wizard by selecting “Form” from the Insert 
menu in the main Access window.) 

Click the down arrow 
next to the 
“Tables/Queries” field. 
A drop-down list of 
available tables will 
appear. Select the table 
for which you want to 
build the form. 

The “Available Fields” 
list will display all the 
fields in the selected 
table that may be 
included on the form. 
To include a field on the 
form, select it on the 
“Available Fields” list 

and click the > button to move the field onto the “Selected Fields” list.  

If you wish to include all of the available fields on the form, simply press the 
>> button. (You can remove fields from the “Selected Fields” list by selecting 
them one at a time and clicking the < button, or by clicking the << button to 
remove them all at once.) The order in which you add the fields, and in which 
they appear in the “Selected Fields” list, is the order in which they will appear 
on the form. 

Once you have moved all the fields you wish to include on the form onto the 
“Selected Fields” list, click Next. Be aware that any fields that you omit from 
the form will also remain blank in any records that you create by using the 
form. 
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The wizard will display a 
list of available layouts 
for the form, such as 
columnar, tabular, 
datasheet, and justified. 
Click a style to preview 
it in the left side of the 
dialog box. When you 
find a layout you like, 
click Next. 

The wizard will display a 
list of styles that affect 
the appearance of the 
form, including the 
colors, fonts, and 
backgrounds used. Click 
a style to preview it in the left side of the dialog box. When you find a style 
you like, click Next. 

Type a name for the form in the “What title do you want for your form?” field 
(the form will be saved with this name).The default name is the same as the 
name of the table you selected. Select whether you want to open the form 
immediately to view or enter information, or modify the form’s design first. 
Click Finish. 

If you opt to open the form immediately to view or enter information, the 
form will appear in datasheet view when you click Finish. The form will now 
be listed in the database forms window, and you can open it in datasheet 
view at any time by double-clicking it.  

If you opt to modify 
the form’s design 
before viewing or 
entering data, the 
form will open in 
design view when you 
click Finish, and the 
Toolbox will appear. 
You may now change 
the position and 
appearance of the 
various controls on the 
form. You may also 
modify existing 
controls or add new ones. For further information on modifying the design of 
a form, on building a form from scratch in Design view the way you might 
build a table, or on building a form based on multiple tables, see Access 
Help. 

You can also create a form without using the Wizard: 
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• Click Forms under the objects list in the database window. 

• Click the New button in the database window toolbar. 

• The New Form dialog box will open, displaying a list of available 
AutoForms (e.g., AutoForm: Columnar, AutoForm: Tabular, and so 
on). Click on an AutoForm to view its description on the left side of the 
dialog box. 

• Once you have selected an AutoForm, click the down arrow next to the 
Tables/Queries field and select the table upon which you wish to base 
the form. The AutoForm will include all of the available fields from the 
table. (Unlike the Form Wizard, the AutoForm function does not allow 
you to pick and choose the fields you would like to include on the 
form.) 

• Click OK. 

The new form will appear in datasheet view, ready for data entry. To save 
the form, press Ctrl+S, or click Save from the File menu. The Save As dialog 
box will appear. Enter a name for the form and click OK. The form will 
appear in the database window. 

How do I create and use a query? 
Queries are among the most powerful tools in the Access arsenal. They can 
be used to sift through the data in one or more tables, allowing you to 
interrogate a database for useful information. They can also be used to 
change or delete data, to perform calculations on data, to select data 
according to specific criteria, and to generate tables and reports based on the 
results of those actions. 

There are many different types of queries in Access including parameter 
queries, crosstab queries, and action queries; however the simplest and 
most common variety of query is the select query. Select queries pull data 
from one or more tables depending upon the particular fields and criteria 
they include. 

To create a query, click Queries under objects in the database window, and 
then double-click Create query in Design view. The Show Table dialog box 
will appear. 

Select the table or tables that contain the fields 
you wish to include in the query, and click 
“Add.” Repeat until you have added all the 
tables that you wish to use. (To add multiple 
tables at one go, depress the Ctrl key while 
clicking successive table names on the list.) 
Click Close. 

The Query Design window will appear. In the 
top portion of the Query Design window, you 

will see the tables you selected in the Show Table dialog box. Each table 
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window displays a field list indicating the fields that may be included in the 
query. Relationships between tables are represented by lines, as they would 
be in the Relationships window (see “How Do I Create Relationships between 
Tables?”). In the bottom portion of the window, you will see the design grid, 
which allows you to specify various criteria for the query and a sort order for 
its results.  

To include a field in the query, double-click the field in its table window. (You 
can also select a field by positioning your cursor in a Field:” cell in the design 
grid. This will cause a down arrow to appear. Click on the down arrow and 
select the field you wish to include in the query from the drop-down list that 
appears.) The field name will appear in the “Field:” row of the design grid. 
Each field occupies its own column in the grid. 

For each field you include in a query, you can specify search criteria that 
must be satisfied when the query is run. Only records that meet the specified 
criteria will be retrieved by Access. For example, you can create a query to 
retrieve CDs by a particular artist from the CD database that we created 
earlier in this eTutorial. Access even allows you to add multiple criteria for a 
single field so that the query retrieves records that meet either, or both, of 
the criteria you specify. 

To specify a single search criterion 
for a field, click the field’s Criteria 
box in the design grid, then enter a 
criterion value. If you wish to 
specify additional search criteria 
that can also be used to retrieve 
records, enter them in the Or box 
that appears below the Criteria 
box. For example, if you wished to 
retrieve CDs that cost either $10 or 
$20, you could enter $10 in the 
Criteria box for the Price field in 
the CD table, and $20 in the Or 
box. 
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Note: When used as criteria, text values must be surrounded by quotation 
marks. Access will automatically surround text entries in the Criteria or Or 
boxes with quotation marks when you press Enter or Tab. 

You can also specify criteria for multiple fields in a query. If the criteria for 
the fields occupy the same row in the design grid (i.e., if the criteria are all 
entered either in the Criteria box or the Or box), Access will retrieve records 
for which all of the criteria are satisfied. For example, if you specify 
ArtistFirstName “Joe” (Artist table) and Price “10” (CD table), entering both 
“Joe” and “10” in the Criteria box of their respective fields, only CDs that cost 
$10 by artists whose first names are Joe will be retrieved. 

On the other hand, if the criteria are entered in different rows (i.e., some in 
the Criteria box, and some in the Or box), Access will retrieve records for 
which any of the criteria are satisfied. For example, entering “Joe” in the 
"Criteria:" row and  “10” in the "or:" row will cause Access to retrieve all CDs 
by artists named Joe, along with the all the $10 priced CDs by all artists. 

You can use comparison operators and logical operators to create more 
complicated queries. Comparison operators like >, <, and = allow you to 
compare field values to constants, and even to other field values. For 
example, you could use the greater-than operator (>) to create a query that 
would retrieve records for CDs that cost more than $10 (>10). 

Logical operators like AND and OR, meanwhile, can be used to create criteria 
that combine several expressions. For example, you could use the AND 
operator to retrieve records for CDs whose price is greater than $10 AND less 
than $20 (10<AND>20). You can even use logical operators to exclude 
certain records from a query. For example, you could use the NOT operator 
to run a query that retrieves CD records that are NOT by particular artists. 

You can include logical operators and comparison operators in a query by 
entering them directly into the design grid, or by clicking the Build button on 
the Query Design toolbar. Clicking the Build button will cause the Expression 
Builder dialog box to open. You can then click the appropriate operator 
button. The operator you select will appear in the elements area of the dialog 
box. Click OK to close the Expression Builder and insert the operator into the 
design grid, where you may now complete the expression. Alternately, you 
can build the entire expression in the elements area of the Expression 
Builder, and insert it into the design grid by clicking OK. 

You can also perform calculations on field values, and display the results of 
those calculations, by creating a calculated field in a query. To create a 
calculated field, position your cursor in the “Field:” row of a blank column in 
the design grid, and click the Build button on the Query Design toolbar. The 
Expression Builder dialog box will open. 

Double-click the Tables folder on the list that appears in the left-hand side of 
the dialog box. This will cause a list of available fields in the table to appear. 
Double-click the field you want to use in the calculation. The field name will 
appear in the elements area of the dialog box. 
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You can now click the button (e.g., +,-,*) corresponding to the calculation 
you want to perform. Alternately, you can click the Operators folder, then 
click the Arithmetic folder, and then click the Arithmetic operator you wish to 
use. Enter any values needed to complete the expression, and click OK. 

You may also specify a sort order for each field in a query. This will 
determine the order in which the query results appear. To specify a sort 
order for a field, click the list arrow in the Sort box, and then specify 
“Ascending” (A, B, C,...1, 2, 3) or “Descending” (10, 9, 8...z, y, x). If you 
specify “Descending” for a field that contains text values, for example, the 
results of the query will be sorted in descending alphabetical order based on 
the values in that field. If you tell Access to sort on more than one field, 
Access will sort each of them starting with the left most field in the design 
grid and working toward the right.  . 

To save a query, click the Save button on the Query Design toolbar, type a 
name for the query in the “Save As” dialog box, and then click “OK.” (You 
may also click Save from the File menu or press Ctrl+S to cause the “Save 
As” dialog box to appear). 

To run a query, click the Run button on the Query Design toolbar, or click 
Run from the Query menu. The results of the query will appear in a table 
called a dynaset. The dynaset displays the records that meet the 
specifications set forth in the query. To return to Design view, click the 
Design button in the toolbar, or click Design from the View menu. 

 

How do I create a report? 
Reports allow you to create effective and attractive printouts of the 
information contained in a database. To print a simple list of the records in a 
table, you can always open the table in Datasheet view and just click the 
Print button, or click Print from the File menu. If you want to enhance the 
appearance and organization of the data as it appears on the printed page, 
however, you can create a report. Reports can be based on tables or queries. 
And since queries can draw upon multiple tables for their results, reports can 
present information from multiple tables, as well. 

To create a report, click Reports under Objects in the Database window, and 
then double-click Create report by using wizard. The Report Wizard dialog 
box will appear. 

Click the down arrow underneath “Tables/Queries” and select the table or 
query on which you wish to base the report.  

The “Available Fields” list displays all the fields in the selected table or query. 
To include a field on the report, select it on the “Available Fields” list and 
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click the > button to move the field onto the “Selected Fields” list. If you 
wish to include all of the available fields on the report, simply press the >> 
button. (You can remove fields from the “Selected Fields” list by selecting 
them one at a time and clicking the < button, or by clicking the << button to 
remove them all at once.) 

Select the fields you want to include on the report. Once you have chosen all 
of the fields you wish to include from one table or query, you may select 
additional tables or queries from the “Tables/Queries” list and choose fields 
from those, as well. Continue until you have chosen all the fields from all the 
tables and queries that you wish to include on the report. Click Next. 

If you wish, you may specify groupings of the records on the report, based 
on up to 10 of the selected fields. When you have specified the desired 
groupings, click Next. 

You can also specify the order of records within each group, sorting by up to 
four fields at a time, and specifying ascending or descending sort order for 
each field. When you have finished specifying the order of records, click 
Next. 

The wizard will display a list of available layouts and orientations for the 
report. Click a layout or orientation to preview it in the dialog box. When you 
have specified a layout and orientation, click Next. 

The wizard will display a list of styles that affect the appearance of the 
report, including the colors and fonts used. Click a style to preview it in the 
left side of the dialog box. When you find a style you like, click Next. 

On the final page of the wizard, type a name for the form in the “What title 
do you want for your report?” field (the form will be saved with this name). 

Select whether you want to preview the report, or modify its design in Design 
view. Click Finish. 
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